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Migration to 25.1

Layout Databases

Database format

Designs from previous releases (17.2, 17.4, 22.1, 23.1 and 24.1) will go through an Uprev process
when opened in 25.1 Layout Editor. Once saved, it will be in 25.1 format

m Allegro X Venture X

The design created using release '17.2" will be updated for compatibility with the current
software. Once saved, the design will be accessible only from the current or later
versions of Cadence software.

File > Export > Downrev Design can save design to an earlier version, but features that
cannot be represented in earlier version will be ignored or may require manual removal.

Click Yes to proceed.

Yes No

25.1 designs cannot be directly opened in previous releases. Downrev is available to save database to
lower release, if necessary -

O Save design to 23.1
@ Save design to 24.1

Design Version Status

Downrev will allow the database to be saved to either release
23.1 or 24.1 database format but saving to a release older
than 23.1 will require opening the design using 23.1 software.

Save... Close Viewlog... Help
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Migration to 25.1

Older Layouts and Libraries

16.6 designs and libraries cannot be used or opened

m Allegro X Venture

|

directly in 25.1 and will require a manual update outside | s e
Of Layout EdItOr USIﬂg PCB DB DOCtOr (ddeCtOf_Ui.EXE) '[f:j;esignwasIastsavedusingversion16.0andmustbeupdatedusingDBDoctor.

Libraries created in 17.2 or later could be directly used in 25.1 -
Library files saved in 25.1 or updated using PCB DB ot s it extersionGideards supprt) -
Doctor will be in 23.1 format, saves to lowest possible Outp dsn(ptonl i 1 npu desin
release, this can be seen using batch command DBSTAT I Ut ORC ochuding B

C:\My_EDA_Libraries\> dbstat soic48w.dra o i

M Regenerate Xnets
soic48w.dra: 23.1 NT -

Adding specific features to a library file will automatically save to version that feature was added

Add OpenType Fonts to symbols will save in 25.1 format so it can only be used in release 25.1 or
higher
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Migration to 25.1

Allegro PCB Router and License Requirements

Allegro PCB Router (RHEL 8 Linux) r—
PCB Router is 32-bit application dependent on a set of 32-bit libraries e e | Bk
not available in standard RHEL 8 Linux install Gloss | UnMiter By Pick

Unsupported Prototypes 4 Elongation By Pick
Required 32-bit libraries could be installed foterChecie
motif, libXp, libXext, libXt, libX11, elfutils-libelf, libxcrypt, glibc ‘0 Ei?ttmmt
Route Editor...

Without required 32-bit libraries installed on system PCB Router and
related commands ( Route > PCB Router > ... ) will not run

Note: This limitation is specific to RHEL 8 Linux installations, Windows will continue to work and no longer
requires 2012 Redistributable Package installed on the system.

License requirements

License file must be updated to include 25.1 license keys, new licenses will be
backward compatible to run previous software releases (17.2, 17.4, 22.1, 23.1, 24.1)
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Migration to 25.1

Allegro Classic Viewer

Software advanced in release 23.1 caused Allegro Classic Free Viewer to be retired in favor of
new Allegro Free Viewer, some benefits of the new viewer are
User-friendly interface, easy for average users, no advanced knowledge of Allegro X Layout tools

Improved layer display controls and access to information using built-in Search and Properties panels

Existing customers using Allegro X PCB Editor sometimes need to open a second session for
viewing purposes of PCB design (.brd) and with different interfaces it can be a challenge
Allegro Physical Viewer is available for the same look and feel but it requires a license

In 25.1, we have restored Allegro Classic Free Viewer for customers to access directly from the

standard Cadence install

There are no plans to provide a standalone Allegro Classic Free Viewer installation, only the Allegro
Free Viewer installation will be available on the viewers download page
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241 ISR6 (August 2025)
Extend Packaging functionality to Allegro X PCB Editor

Provide access to select functionality available in Allegro X Advanced Package
Designer inside of Allegro X PCB Editor

Select existing Packaging licenses as a Product Option

:: 25.1 Allegro X Venture Product Choices X
Advanced Chip-on-Board Wirebonding
Increase wire bond limit from 100 pins to unlimited llgro tnverpris P Designer
Allegro X Designer Plus
Allegro X Artist
Allegro X Designer
Metal Density Scan Report
Reports localized metal density across each layer of design T ——
- M Advanced Technology using APD Professional h SIP4200SC
ManUfaCture > Metal Dens,ty Scan B Advanced Technology using APD Expert 4_ S|P43005c

B Use as default B Legacy products B Reset license cache

Symbol Spreadsheet Import Command

Spreadsheet import to assign Net Name to pins of an existing Symbol
File > Import > Symbol Spreadsheet

© 2025 Cadence Design Systems, Inc. All rights reserved.
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Performance Improvements
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Performance Improvement Overall Strategy

Continuous Improvement

Improvements to existing algorithms in

every release (ISR, QIRs, Base)

Driven from customer and proactive

i.e. Push Connectivity

© 2025 Cadence Design Systems, Inc. All rights reserved.

Infrastructure Improvements

Targeting annual major releases

Medium term projects with known solution
strategies like ongoing DRC
improvements, voiding improvements, etc
— targets 1 or 2 major releases

Scan Window based, multi threaded
Boolean engine operations to help a range
of applications DRC/DFM checks

Multi threading infrastructure for general
algorithm pipelines

i.e. Acute Angle Checks

aﬁ

Long Term Improvements

In Prototyping/Discovery — plan will be

published in the future (TBD)

Long term projects that are still under
discovery and prototyping to address
structural issues like scalability

i.e. Hierarchical Objects (i.e. Modules)

cadence



Performance Improvement — In Every Release!

Action

_

maII Place Rep Module Import O 01:09 0 00: 36 Report Any SlowneSS
—-

Please file performance related CCRs!
m For any COmmandS that you f|nd that are

or iy < e L L [T

slower than you think they should be

Delete Via Structures | 1520200 11| 037:17] 249 :

Please include test cases so Cadence
nsert Vief Via Sching/ Flace Stractures | o143 90| oooes| 2.1 can analyze, prioritize, and address

X times FASTER compared to benchmark times!
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Areas with Recent Performance Improvements
6/16/2025 release and newer

DRCs

Import and Export Design Data (i.e., Die Text In, Module Import, etc.)
Placement/Interactive Placement (i.e., Modules, Structures, Move Die, etc.)
Routing/Interactive Routing

SKILL & Ravel code runtime

Dynamic Shapes and Voiding

Designs with huge number of padstacks

Refresh symbol, DBDoctor, Report

Via Array (i.e., Delete), Degassing

Show Element, Display

3DX View/3D Canvas DRC

In-Design Analysis (IDA)
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Core Functionality Updates
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Positive Masks

More realistic view in 2D helps clearly communicate design intent
3DX Canvas, Allegro® X PCB DesignTrue™ DFM technology and manufacturing output

Positive mask dynamic shape uses Mask pads and other static objects to create mask openings

Simple option in Cross-Section indicates Positive Mask new dynamic layer
No library/design changes required; all traditional negative mask objects generate openings
in mask

& Cross-section Editor I 1 03 — C3A2

— R2A1 =
us 1} - S1A1 = C3A1 = Sy
Export Import Edit View Filters ca d enc e' ! E[ ] REBOOT, [ Riu C3A23 C3A4 ] = J 4 A 1). ‘
¢ ¢ = 5V _IOREF 3.3y DS2A1 a3 S Zis B @ ‘
: us U AN : SR Fije K, o —
Primary —y 3 S o™ 3022 RIAZ W) & o, U8 —
| e .  Power! 25, gz canz2 n' s 20) us S —
e P R e e O> RESET 10REF R .o
Objects Types P  Thickness P Physical Al 6| |1 ] | =t I[ i ]:1 [ Kcanzo,, =
CaAze - Lo -
2A2 ) 20~ & =mae 2
Val JTAS. VIN GND GNP 5V 3.3V o > g £ s
# Name Layer Layer Function - Layer Material Fillin | Negative Rt RIAT= = gll:; = ] J:Z;M Ea (2¢ ///'\)‘P [1= : > =l El L =
b Y T D Material Artwork = Mask o RLABL :| ‘ |; ETRE = At < canz1 COIN B
mi — Tx ——a T . >
CiAML =5 A Letae - UzZA3 €2 3{§ By = Y2Al J3Ai 2":1‘“ =
= T oo -
- o - - - - pME=s =2 ClAs cinlsﬁlc“l‘ o= 2 = i e
/ CIAT = 285 zxrxczdmmone> = paar 2l ]E === czA%Rz?o 2 RIAL4 BT o
Surface = =2 — = = > —- — N
e g}:”.—. = [ = E;;EE;EE mom 4?//\&" RaAlt:Jla‘leTarja[]
SOLDERMASK_TOP I".’L.sl( Is@ der Mask |8 Solder Mask R1ALE — — RoLIENZS e L3A1 P 0 S TOPIE oo -
> C1A5 C1A6 C1AT_ C1A8 — TR
1 ITDP Conductor Conductor 1.9 1 Copper o —_ = : ‘z Il I §[ 8T ”/rCJAIS' [T}
= = > — U
Dielectric Dielectric 2.65 Fr-4 ‘ |E = - 2 10 R3A19 C3AL Tl Icc45 P
o
2 PWR Plane Plane 13 p) Copper [ ] J1 ciaze— ST Claze ) ‘ i~ 3 |0
jelectri ciaee | =2ET Zees > L JeaneE ot
Dielectric Dielectric 50 Fr-4 o 5 == o L o P gl
3 I LYR_1 Conductor Conductor 1.2 3 Copper . = C3B1 g |ZO 131 o s
(12 = w - e 2 30 ¢
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~146-

- ; 0 Dsply Desgn Tt Shapes lowPlaing Rte Mig Appcatons
OpenType FO ntS - Wldth Scal I ng 50 /0 Font Styles lmmm Map used Text Block to Font Style | Advanced Settings [ ]
_-'l 92 |'-_ Style Name Font Height ~ Width Scaling Line Space  Formatting
- - Silk RefDes SM ~ Arial 30MIL 80% 36 MIL B /
_ Wldth Scallng 100% Silk Markings LucidaSans  SOMIL  100% 60 MIL B /
Allegro® X PCB Design Platform has one standard block font for e e o S e I
canvas rendering and manufacturing outputs S S T mow BT
OpenType Font support:
Input/edit text in specific font with consistent exports in manufacturing output and 3DX Canvas
Develop Styles to store font, % width, height and formatting (bold and italics)
o . 0 Options - X
Allegro X PCB DesignTrue™ DFM technology performs detailed checking of new fonts
3DX Canvas support and visualization of OpenType fonts T
Allegro X text blocks still supported with mapping to a new font style oy T
No library updates required; font replacement can be driven in layout ===8B1
; T e e uzsu::i?::"’ o Hla 20 .
- —\: é.g - ’ . DIGITAL(PWM-) —\RM. i %EE " W L
|fr ! A = |¢§ et be mbbis ;--. :JSB:
Neooeoooe meeeceeocee L _ mHoeooooo0e HOo00000O®O® @ 282"
o = = J1B1 J2B1 . as ©28% 5287 —
° L ° — — E E " L N N J1B2 - — — stm R2B25 ,\” 0_229--2 E Eg
0000 = = @0 O0® = = B3 wm'® 5% 3B Q-
. ‘‘mee - = milm R . ‘mee = = mnm, miilimSs
11 [ (T 1 [] U2B4 mEEmus JENEQ™
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Usability Improvements
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3DX Canvas

Visualize Object selection(s) in 2D Canvas using via
application mode RMB > 3DX Canvas
Display in 3DX Canvas — pre-selected objects

Add to 3DX Canvas — Append newly selected objects

CrOSS PrObe from 2D to 3D 3DX Canvas » Display in 3DX Canvas
Application Mode v | Addto 3DX Canvas
Super filter 4 Cross probe in 3D
Customize *
Selection set s

Added support for Ribbon Bonding and Attach Points for
Packaging Designs

© 2025 Cadence Design Systems, Inc. All rights reserved.

Bond Finger

(a) Ball Bond (b) Wedge Bond

cadence



3DX Canvas

Several updates to support In-Design Analysis
Workflows in 3DX Canvas, including removal of
Legacy Artwork 3D Viewer dependencies for
Packaging.

3D Canvas has been deprecated in this release and

will be removed in an upcoming release

Customers should migrate to 3DX Canvas for ongoing support
and enhancements

© 2025 Cadence Design Systems, Inc. All rights reserved.

File View Camera

Teols DRC  Help

vl
SREHT— s+ b SRLE nS

(460.030, 804,650, 45.344)

Legacy 3D Design Viewer (Packaging)

Included Layers

All Layers Outer Layers

Silkscreen Layers

Pkg, Brd, RefDes AutoSilk

Included Objects
All Objects
Clines Lines Text Pins
Vias Shapes Rectangles
Symbols Masks Dielectrics

Symbaol Precedence

Primary Models Secondary Models

3D Canwas has been deprecated and will be removed in an upcoming release, Customers should migrate
to the 30X Canvas for ongoing support and enhancements.

B Do not show this dialog again

OK Cancel

cadence



Docked Search and Reports Panels

Docked Search Panel .
Direct access to information organized in O =

Components (535) Nets (432) Pins (2096) Traces/Wires (1814) Shapes (3041) Vias (1148) DRC (85)

Se pa rate O bj eCtS ta bS REFDES & PART NUMBER FOOT PRINT LAYER ROTATION MIRROR X LOCATION YL

Cross Probing ability between Search Panel
and Canvas & CAPN_0402LF-0.1UF,10%,16V,0402LF SMCO0402A Top 90.000° NO 3291500

° NO 7046.000

C1A1 CAPN_0805LF-10.00UF,10%,6.3V,0805LF  SMC0805 Top 0.000° NO 723.000
Alte rnatlve to F| nd By Query and ShOW Element C1A2 CAPN_0805LF-10.00UF,10%,6.3V,0805LF  SMC0805 Top 0.000° NO 798.000
C1A3 CAPN_0402LF-0.15UF,10%,10V,0402LF  SMCO0402A Top 90.000° NO -31.000

Integrated DRC Browser content

Docked Reports Panel X

Migration of select Quick Reports into a new e | 7 Shadow vioce (@D | Wreset
Reports Panel Dangling Traces {257) Dangling and Antenna Vias (565)

3] - TYPE PADSTACK X LOCATION Y LOCATION START LAYER END LAYER OK DANGLE

Al IOWS q u |Ck canvas n aVlg atlo N d u rl ng Re port AQ_GPIO Antenna VIA_20-10-28_SMB 316,000 2037.000 TOP * BOTTOM No

. A0_GPIO Antenna VIA_20-10-28_SMB 542.000 2343.000 TOP £ BOTTOM No
Reviews

AO_MUX Antenna VIA_20-10-28_SMB 2970.000 2040000 TOP * BOTTOM No

Al te rn atlve to ﬂ Oatl n g H T M L V| ewer W| n d oW AO_MUX Antenna VIA_20-10-28_SMB 520,000 2300.000 TOP * BOTTOM No

AON Antenna VIA_20-10-28_SMB 3824.000 408000 TOP £ BOTTOM No

Will continue to migrate other key reports into
this new Report Panel

© 2025 Cadence Design Systems, Inc. All rights reserved. c a d e n c e®



Pin Delay Import

rm Pin Delay Import X

Pin Delay File: |RefDes Pin Delay.csv

More capable than legacy feature providing ability to ndeoes sy v R
i m po rt Seve ra I fo rm atS Reference Designatorwyr Ignorewyr Ignore W Pin Numbewgr Delaywr Unit wr

Any Microsoft Excel file (.csv) e e o wen
u2As U::y BI 94.982 pps
Allegro ® X Constraint Compiler — ObjectRule Table (.csv) "
U2A5 AN22 DDR3_MA<1> Bl 93.125 ps
Existing Pin Delay format - e
U2AS5 AP14 DDR3_MA<14> Bl 94982 ps

Loading CSV file in dialog will auto-detect columns and T —

validate data prior to import
Ability to adjust columns categories and cell values Undefned Delay Units il s

Queries database to ensure Reference Designator and Pin number ety ey | ey [ e Y Y Gy

. . . . . . U2AS5 AL25 DDR3_DRAM... Bl 98.747 ps

combination exists, red color swatch cell indicates mismatch o B oo §

. U2AS5 AN17 DDR3_MA<7> BI 94.982 ps

Uncheck rows that should not be imported o o = 5

U2A5 AN22 DDR3_MA<1> BI 93.125 ps

U2A5 AN24 DDR3_MA<1... Bl 98.747 ps

U2A5 AN29 DDR3 CAS N BI 97912 ps

U2AS5 AP14 DDR3_MA<1... BI 94.982 ps

U2A5 AP16 DDR3_MA<9> BI 95.223 ps
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Differential Pair Automatic Setup

Several ways to create Differential Pairs, manual and automatic, each having benefits but no

centralized way to complete the task

E Auto Differential Pair Generator

= Differential Pair Automatic Setup

DiffPair name prefix (optional): DP_

" [xnet ¥ | prefix. [op_ | + Fitter: [ Dp_cH | - Filter: | DN_cH
Net name suffix for I
. ' All Xnets Diff Pair" | Diff Pair v | + Net - Net
+ polarity: DP_CH |
- polarity: DN_CH ! 2P4GHZ_ANTENMNA DP_USBH2 USBH2_DP_CH USBH2_DMN_CH
2P4GHZ_ANTENMNA_RP DP_USEHO USBHO_DP_CH USBHO_DM_CH
Use of bus bit syntax <n> is handled when forming
diffpairs. For example, nets of two busses DATA_P<n> and Filter: Close Hel
DATA_M<n> can be formed into a diffpair with a name ' P

DP_DATAn by prefix=DP, + polarity=_P and - polarity=_N
where <n= is the bit number.

Generate Cancel Help

Integrated all best aspect of previous solutions into a single dialog to

generate Differential Pairs quick inside and outside of Constraint
Manager

Logic > Assign Differential Pair in Layout

RMB > Create > Differential Pair > Auto Setup in Constraint Manager

© 2025 Cadence Design Systems, Inc. All rights reserved.

E Differential Pair Automatic Setup

Diff Pair Polarity Indicators:

W +- PN
M _POS,_NEG W TC

User Defined Polarity Indicators:

Positive: |_DP_CH MNegative: | DN_CH

Prefix added to Diff Pairs: |DP_

Diff Pair Name ¥ | Positive Negative
DP_USBH2 USBH2_DP_CH USBH2_DMN_CH
DP_USEHO USBHO_DP_CH USBHO_DM_CH
DP_REFCLKO REFCLKO_P REFCLKO_N
DP_REF1 REF1_P REF1_N
DP_PCIEQ_TXO PCIED_TX0_P PCIEQ_TXO0_N
DP_PCIED_RX0 PCIEQ_RX0_P PCIEQ_RX0_MN
MNumber of Diff Pairs: & Cancel

Create Diff Pairs

cadence



Smart Search

Available Properties - Predictive Search Results

Assigned Properties

( Single-click to view description / Double-click to add property ) Delete  Property Value

Backdrill_Override
Backdrill_ Comp_Side_Allowed | | Backdrill_Override

Navigational guidance within the tool to support S
everyday design activities
Locate/apply object properties without advanced

Property Description

knowledge of property name along with providing

mandates backdrilling always occurs from the specified side to the

detailed description of its use (no more scrolling thru a e v o e s ot by <ol oty
The property may also force backdrilling of a pin or via normally

s A A luded fi backdrilli It of bei hi
||St Of propertles ||St) :xdc:e rom backdrilling as a result of being a test point on that

User Preferences Editor finds your preferences quickly o || o | [ e BN IO
and easily (beyond searching thru descriptions)

r
i E User Preferences Editor

Categories Category: | Predictive Results

= My _favorites Preference Value Effective Favorite
P @ Display modulepath Command |
P = Drawing external_drc_reuse_layers | Command |
: :- BT swapcomp_acrossmodules | Command |

. " [ " B File_management .

Plans to continue expansion in different areas on > = o v
" = disable_module shape _convert | ] Immediate | ]
future releases (SKILL® API, Padstack Edit, = essopisnirese W -
. . —_— icp_text_wizard_all_rel_pins | ] Command | |
Constraint Modes, Constraint Management) : w
pad_repl_use_new_padlayer | Command |

Summary description

Category: placement/general
Set to disable shape conversion and maintain dynamic shapes in the target design as defined in the module. This applies to both the Design Reuse and Place
Replicate module flows. By default, dynamic shapes in modules will be automatically converted to static to maintain design intent when placed in a design.

OK Cancel Apply List All Info... Help

This slide contains forward-looking statements regarding Cadence's business or

© 2025 Cad Design S , Inc. All righ d. . . A a
sj€adenceesionSystams, ine«inghis esane products. Actual results may differ materially from the information presented here. cadence



Constraint Management
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Constraint Panel — Gateway into Constraint Manager

New Constraint Panel offers a streamlined and intuitive way to manage design constraints
directly within layout canvas (Physical, Spacing, Electrical)

Access to all existing Constraints Sets with the ability to create new Constraint Set as required

Constraints

B m B
Current Object: Design PCIE_CARD

» Object Hierarchy - Rule Set References
» Electrical (ECS_My_Basic)

Constraints

B m B
Current Object: Design PCIE_CARD

» Object Hierarchy - Rule Set References
» Electrical (ECS_My_Basic)

© 2025 Cadence Design Systems, Inc. All rights reserved.

Constraints

S
B m B
Current Object: Design PCIE_CARD

» Object Hierarchy - Rule Set References
v Electrical (ECS_My_Basic)

¥ Physical (PCS_My._Basic) » Physical (PCS_My_Basic) Basic Advanced
. ‘¥ Spacing (SCS_My_Basic)
Basic Advanced Rule Set [ECS_My_Basic >+ m® DRC Modes
Basic Advanced

Rule Set PCS_My_Basic v+ B\ DRC Modes Layer Type [All Layers v Enable All Basic Checks (@)
Rule Set |SCS_My_Basic v + i} DRC Modes

Layer Type Al Layers v Enable All Basic Checks (@) m = »
Layer Type External v Enable All Basic Checks (@) Wiring.

Line Width Ratsnest Schedule  Min Tree ¥ Stublength 10000
G
2pacing Verify Schedule  Yes ¥ MaxViaCount 2

Schedule Preview

< 2> O
A o Max Neck 2 T Y @---.@----@
Differential Pair 600 300 600 / -
O Omingd o
A 0¥ A 0 3 IR @
NeckGap 500 Gap 650 7i0 7\.;0 6£O / @

Total Etch Length = A+B+C+D+E+F

Minimum  0.00

Gather Control Max Length
Uncoupled Length fingore ! 15000 Maximum 500000 .n.“.
viatist 4 % [ Z , H
Name Start End . .
J viari4s Top Bottom 0 ¢
L BBVIAR14.8.1-6 Top L6_Pwr
= UVIAR14.8.1-3 Top 13.Sigx

cadence



Constraint Panel — Gateway into Constraint Manager

Enter values on hierarchal object to seed value at lower levels
Basic and Advanced slider expands to show more detailed Spacing rules

Navigate to lower levels only when exceptions are required

w Spacing (SCS_My_Basic) w Spacing (Default) w Spacing (Default) ¥ Spacing (Default)
Basic Advanced Basic Advanced Basic Advanced Basic Advanced
Rule Set |SCS_My_Basic >y + @ m DRC Modes Rule Set |Default vy 4+ o B® DRC Modes Rule Set |Default v+ OB DRC Modes Rule Set Default 4+ 0 H® DRC Modes
Layer Type External v Enable All Basic Checks . Layer Type Conductor v Layer Type |Conductor \/ Layer Type Conductor -
. All. 1:Top ' 2:12.Gnd 3:13Sigx 4:14 Sigy |5:L5_Pwr = Alll 1:Top [2:12.Gnd 3:13Sigx 4:l4Sigy | 5:L5 Pwr = Al 1:Top 2:12.Gnd 3:13.Sigx 4:14 Sigy |5:15 Pwr a
Spacing | L = _|
6:L6_ Pwr  7:L7_Sigx 8:18.Sigy ' 9:L9.Gnd 10: Bottom V) 6:L6 Pwr  7:L7 Sigx 8:18 Sigy ' 9:L9.Gnd  10: Bottom V) 6:L6 Pwr  7:17 Sigx 8:18 Sigy [9:19.Gnd 10: Bottom
@#@ Spacing  Pad Type Spacing Hole Spacing Hole Type Spacing Spacing  Pad Type Spacing Hole Spacing Hole Type Spacing Spacing  Pad Type Spacing Hole Spacing Hole Type Spacing
A A
6"30 Bio 6':,0 Spacing Hole Spacing All Holes v Thru Via Pad =
“ - Holes to All Features: ~ 8.00
Via Pi
; O @ e | W e Y 2
A A 1‘ 1‘ a
7.00 7.00 6.00 A A A . ’ ’ ’ . A A A A
‘l/ v v ) 8.00 6.00 7.00 ) A A A A S 60 A A o
v J v v v 8.00 8.00 8.00 8.00 8.00 v v v v
. OraChEaE NN
o ] L] q Pin Via () ) | )| ) |
A ) A A A Pad Pad e Y A A
7.00 7.00 6.00 6.00 6.00 i
‘ll Vv ¥ Vv v § 6‘.;0 7.00 *
Basic Pad values seeds Advanced via : . e J
Spacing Via Pad and Pin Pad val Shape  Shape  Shape Pad Advanced Spacing Via Pad U lne
acin 1Ia Fada an In Faa vailues H H
P 9 value seeds Thru Via, BB Via
and uVia under Pad Type
Spacing to expand value entry

cadence
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Constraint Panel — Gateway into Constraint Manager

Select object(s) on canvas to display resolved constraints with

associated Constraint Set assignment

Constraint Sets can be added at many levels, but it is important to understand
the highest level will influence results on canvas

Focus on controlling constraints at an abstract level, instead of Net level, by
assigning Constraint Sets to hierarchal groups (Net Group, Net Class, Diff Pair)

Row and Constraint Set will be highlighted indicating resolved
constraints with Constraint Sets driving rules activated under each

domain for quick reference
Adjust Constraint Set or create a new Constraints Set for assignment

Everything at your fingertips without opening Constraint Manager

© 2025 Cadence Design Systems, Inc. All rights reserved.

Constraints

o - 1

B m B

Selected Object  Trace Air Gap Distance Selected Object Trace

Net Name DDR_DQO 11.00 mil Net Name DDR_A10

Layer L4_Sigy Layer L4_Sigy

Width 5.00 mil Width 5.00 mil
¥ Object Hierarchy - Rule Set References

Type Name ; Electrical ->F- Physical I Spacing @ Same Net Spacing

Dsn  PCIE_CARD Default ¥ Default w
NGrpwDDR_DQ ¥ 500HM w 10MIL v
DDR_DQO DDRDQ ¥ v v
NGrpwDDR_ADDR ¥ 600HM w 15MIL v
XNet  DDR_A10 v  G0OHM W 1SMIL W
NCC DDR _DQ:DDR_ADDR 20MIL v
» Electrical
» Physical
¥ Spacing (20MIL)
Advanced
Rule Set 20MIL v+ OB DRC Modes

Layer Type Conductor v

Al 1:Top 2:12.Gnd 3:L3.Sigx 4:L4.Sigy 5:L5_Pwr a

6:L6_Pwr  7:L7_Sigx 8:18.Sigy 9:19.Gnd  10: Bottom

Spacing  Pad Type Spacing Hole Spacing Hole Type Spacing

Spacing
“ = “
Pad
20 00 6 00 zo 00 6 00
0 00 o 00 0 00

» Same Net Spacing

Default

j= j= o o
s & & & &
=B E
2 e B E

4 8 8 N

cadence



Topology Workbench — Topology-based Constraints

Signal Explorer (SigXP) has been used to generate topology-based constraints, but we now

have a next-generation topology editor called Topology Workbench

Topology Workbench offers similar functionality to SigXP, with an improved Ul and a simpler use model
Re-schedule Net, drive constraints globally across the Net or create Pin Pair based constraints

Start Page m_ma_0 b4

om

Properties

Q Search
w Selection Filter
All Objects (1)

Component Connect Line (1) Marker Note Pin Property
¥ Constraints

XNet DiffPair
» Wiring

» Propagation Delay

¥ Relative Propagation Delay

Match Group Pin Pair Scope Delta:Tolerance (mil)

ADDR1 U2A5.AR24:U1B5.K3 Glob

ADDR2 U1B5.K3:UT1A1.K3

P Impedance

» Vias
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Topology Workbench — Topology-based Constraints

|deal Transmission Lines (TL*) are no longer required for Electrical CSet Topologies
RMB > Delete all Connections on canvas will delete all T-Lines so pins can be easily rearranged / reconnected

New T-Point symbol can be placed to form a branch point to split route to different pins

Allows matching rules to be applied from T-Point to each component pin.

Ambiguous pins, pins with same Pin Use, may not produce correct schedule order when applied
Applying a Mapping Tag in Topology and in the design will remove ambiguity resulting in correct routing schedule

o E&: - ; +t>

| 11BA5

8,/
-

Add TPoint

i

_
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Manufacturing Output
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Manufacturing Output — Single-Click Export

Avoid madness of jumping to different areas of tool to export each data type
Customers developed export automation, routine maintenance is a challenge, so functionality must be built-in

Custom Export configuration used to ensure quick and complete export
Out-of-box configuration with standard outputs grouped by manufacturing focus that can be customized

Define Export configuration once and use it for all designs for a consistent can complete data export

¥ ¥ Fabrication_IPC2581
IPC2581 Database (Fabricaticn)

Fabrication Drill Wiew PDFs

Artwaork
abrication_Gerber

>
> Fabrication_ODB ++
B ¥ Assembly

¥ v PCB Design Report
Summary Report
Unconnected Pins Report
DRC Report

Etch Length Report
Database Diary Export

Artwork

W ICT Test Data

Testpoint NC Data File
Testpoint Report

IPC-D-356 Netlist

Artwork

»

Setting

IPC 2581 Version 1PC2581-C =
Output units Inch v
o > Pin one orientation | OTHER <

Functional Mode FABRICATION ~

IPC-2581 Config

w Vector text

Compress output file(.zip)

Fabrication

v +
- +
+

v Archive  ConfigFille. >  Export Close  Viewlog..
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» Fabrication_IPC2581
¥ ¥ Fabrication_Gerber

¥ Artwork

Setting

Format

Qutput Units

¥  External Conductor
&  Internal Conductor
%  Internal Plane
¥  Internal Negative Plane
~  Silkscreen
¥ Soldermask
¥ Solderpaste
Fabrication Drill Views
Assembly Drawing Views
NC Drill - NC Route
IPC-D-356 Netlist
Backdill Repart
Fabrication Drill View PDFs

Artwork Film Record PDFs

Assembly Drawing View PDFs

Fabrication_ODB++

¥ Assembly

»

»

B ¥ PCB Design Report
P ¥ ICT Test Data

»

Integer Places
’ Decimal Places s

Advanced v
Scale Factor
Prefix
Suffix
Size Limit

X

Y

Supress

Artwork Config

Gerber RS274X ~
INCHES

2

Continue with Undefined Aperture

24.00000

16.00000

¥ Leading Zeroes
Trailing Zeroes

¥ Equal Coordinates

+

w Archive Config File.

v |Export | Close | Viewlog..

¥ Fabrication_IPC2581

Fabrication_Gerber

»
»
» Fabrication_ODB++
v

¥ Assembly /
IPC2581 Database (Assembly)

¥ Artwork

External Conductor
Internal Conductor
Internal Plane
Internal Negative Plane
Silkscreen
Soldermask

¥ Solderpaste

Fabrication Drill Views

Setting
IPC 2581 Version IPC2581-B 7
Output units Inch v
Pin one orientation | OTHER 7
Functional Mode ASSEMBLY v
Functional Level 2 =

IPC-2581 Config

v Vector text

Compress output file(.zip)

Assembly

Assembly Drawing Views
Assembly Drawing View PDFs
Fabmaster Extract File
BOM Report
Companent Placement Report
Testpoint Report

Testpoint NC Data File
Artwork Film Record PDFs ~ +
» ¥ PCB Design Report

B ¥ ICT Test Data

v Archive

ConfigFile.. v Export Close  Viewlog..
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anufacturing Output — Single-Click Export

Each export can have its own parameters for quick access through Export form
IPC-2581, Artwork, NC Dirrill, etc.

Create export groups for each manufacturing resource; no rearrange of output data manually

Common configuration shared with 24.1 Artwork Film Record auto-generation for a complete and
consistent manufacturing data package

» Fabrication_IPC2581 Setting » Fabrication_IPC2581 Setting » Fabrication_IPC2581 Setting
[N Fabrication_Gerber IPC Version IPC-D-356 v R oCricatior_Cerber ¥ Export Board/Symbol Outline if Pins Exparted » ¥ fabrication Gerber
. F: 0 Filter Drawing Ori F:
¥ Artwork Board Title TC3100 i abrication_ODB.++ Ff er H'E‘”"”é! rigin » abrication_ODB++
ilter Header/ er
. - ¥ v Assembl B ¥ Assembl
¥  External Conductor Identification Number 50-203-1234 ssembly B rroperty Omtons ssembly
1 v PCB Des
¥ Internal Conductor Revision A IPC2581 Database (Assembly) & Comp @ Net @ Testpoint il
¥ internal Plane ¥ Artwark Tais iz iz Summary Repart
¥ Internal Negative Plane GRS Pin Via Shape Traces '
gati External Conductor Unconnected Pins Report
- y Header File
Silkscreen Internal Conductor Advanced v DHCRSRS
¥ sl Ignore Backdril
Sl & Internal Plane Filed Pads Etch Length Report
¥  Solderpaste Ignore Die Layers | Negative P!\
Internal Negative Plane Tl S Database Diary Export
Fabricaticn Drill Views ——
. 2 Filter Hol
Assembly Drawing Vig e Holes Artwork v o
== on Ig = Filter Traces
NC Drill - NC Route ¥ solderpaste
Netl ISt Black and White T
IPC-D-356 Netlist Fabrication Drill Views fest Data
) Separate PDF for Each Artwark Film usiom
Backdrill Report Assembly Drawing Views

Security Testpoint NC Data File

Fabrication Drill View PDF Assembly Drawing View PDFs stpoint E
o o Vi £ y o xports
Artwark Film Record POFs Fabmaster Extract File IPC-D-356 Netlist

Assembly Drawing View PDFs v + R A 3 A Artwork ~ +
Companent Placement Report
Testpoint Report
3 Fabrication_ODB++ _ ) » *
L e Testpoint NC Data File PDF Config
B ¥ PCB Design Report Artwork Film Record PDFs v *
P ¥ ICT Test Data
» + » ¥ PCB Design Report
ey
v Archive  ConfigFile. v | Export Close | Viewlog.. v Achive  Configfile. v  Export  Close | Viewlog . v Archive  [ConfigFile.. v | Export | Close | Viewlog..
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Upcoming Features in 25.1 ISR
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Copy / Paste Layout

Reuse of sections from a previous layout can be a great time saver
Leverage placement and routing from a known good layout
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Functionality like Sub-Drawing and Place Replicate can help complete
the task but sometimes requires file modifications for a clean import
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New Copy/Paste Layout allows copy of placement, routing, etc. from one design to another

without saving or managing files
Open the source design and drag a window RMB > Copy Layout

Open the destination design and RMB > Paste Layout

This slide contains forward-looking statements regarding Cadence's business or

© 2025 Cadence Design Systems, Inc. All rights reserved. . . . .
products. Actual results may differ materially from the information presented here.
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Mapped stackup Destination stackup

L2_GND L2 GND

Copy / Paste Layout

L4 GND

Pre-select objects from source design than copy data into buffer using
RMB > Copy Layout or Edit > Copy Layout

L6_GND

L7_+2V5

L8 +3V1

19.GND

Paste Layout into destination design using RMB > Paste Layout will

present a Layer Mapping dialog to map layers between source—destination
Move layers one at a time or drag select multiple layers to move as a set

111_GND

[RENE ]

Source stack-up cannot have more layers than destination

14_+2V1
15 +3V1
L7_GND

I
Original Reference Footprint Value New Reference S
. . . . . g €S0402.01_ 01UF Conductor layer .
Mapping dialog to link source—destination Ref Des i i 3
. . 83 CS0402 011 0.01UF €102
New reference filtered by Footprint and/or Component Value ooy oo |00 Conce Nox
€86 €S0402_01_1 0.01UF El;‘;
C164
87 €S0402_01_1 0.01UF [C165
C166 ower and GND Mapping
. . c89 (€S0402_01_1 0.01UF [C167
Power and Ground Net Name mapping dialog allows — . S —
mapping nets between source—designation rmonsos |u v M
GBESW_VDDAH
New Reference match based on Eéﬁ%q
same footprint +1.25V1
i ) : [Fires@rve nets oz\Sli'\dpes e / :1:;::
Options to Preserve Net Names on Shapes and Vias = g
Cancel Paste Cang GND =
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